
UUSSEERR’’SS  MMAANNUUAALL  OOFF  TTHHEE  CCCCWWLLFF  DDAATTAA  BBAASSEE  
WWIITTHH  AARRCCVVIIEEWW  GGIISS  SSYYSSTTEEMM  

Our thanks to those who gave us a possibility to begin our work with ArcView GIS, 
the master software for desktop GIS and mapping. ArcView gives us the power to 
visualize, explore, query and analyze data geographically from CCWLF Data Base. 

Our first experience of ArcView GIS project making you can see below.  
 
The project is made on ArcView GIS 3.2a Version 
The project includes: 
• Installation of CCWLF Data Base (DB) dynamic linking.  
• Creating of the new maps. 
• Loading existing data from CCWLF Data Base to ArcView joining them with a 

theme’s attribute table. 
• Using of ArcView SQL connection feature and SQL query run to retrieve 

hydrological and meteorological records from CCWLF DB. We have an access to 
the records, which become table in our project. We can analyze and display this 
data in the diagrams for example.  

• Laying out and printing maps. 
 

IIInnnssstttaaallllllaaatttiiiooonnn   ooofff   AAArrrcccVVViiieeewww   GGGIIISSS   333...222aaa      ooonnn   yyyooouuurrr   cccooommmpppuuuttteeerrr   aaannnddd   
llloooaaadddiiinnnggg   ooofff   ttthhheee   AAArrrcccVVViiieeewww   CCCCCCWWWLLLFFF000666   ppprrrooojjjeeecccttt      

 
During the installation process the Setup program prompts you to choose where you 
want to install ESRI ArcView GIS 3.2a software and the type of installation you want. 
You need to choose the Typical installation, which installs the most frequent using 
components of ArcView GIS. You can install ArcView GIS directly on your hard disk 
from a CD-ROM or from a network location. See the section ”To install ArcView 
GIS” for more information. 
 
Do this after ArcView installation: 
• Find Esri folder in operative disk. 
• Set the CD-ROM with the CCWLFO6 project to the CD-ROM drive 
• Copy “Av_gis30” and “Esridata” folders from CD-ROM to the “Esri” folder, 

changing the file names if they have already exist. 
 

IIInnnssstttaaallllllaaatttiiiooonnn   ooofff      DDDaaatttaaa   BBBaaassseee   CCCCCCWWWLLL   llliiinnnkkksss   wwwiiittthhh   AAArrrcccVVViiieeewww   ppprrrooojjjeeecccttt   
 
ArcView GIS supports SQL (ODBC) database links, which allows ArcView GIS to 
connect to SQL databases via Open Database Connectivity (ODBC) drivers. The 
ArcView GIS Setup program installs the necessary files for the ODBC Data Source 
Administrator. However, ArcView GIS distributive doesn’t includes any ODBC- 
drivers. To get information about ODBC- drivers installation  please apply to ODBC- 



driver description. ArcView is compatible with a majority of all using drivers. The 
main is that 32 bits drivers are need for SQL-linking with DB.     

Creation of ODBC Data Sources 
Data Source for ArcView need this for making CCWLF DB:   
1. Make sure that CCWLF folder with DB is located in radical directory of your 

computer. 
2. On the ‘Control panel ’ ‘My computer’ find ‘ODBC Data Sources’ and ‘User 

DSN’ insert.  
An ODBC User data source, store keep, the information about installation of 
Source links. A user data source is visible only for you. And can only be used on 
the current machine. 

3. Input Data Source name ‘CCWLF’ into column ‘name’ 
4. Click the “add” button and select a driver for which you want to set up a data 

source. 
5. Press ‘OK’. 

 
 

Opening of  the ArcView  CCWLF06 project 
 
1. Start ArcView, cancel the Welcome dialog and you’ll see the ArcView application 

window. 
 

 
 

 
2. Click the “open an existing project” radio button, then press OK. 

A  project  is a file in which we store our work. Project file names have an *.apr 
extension. 



3. Set the cursor in the dialog window on “esridata” folder name, where our project 
data are located. Double-click the ‘esridata’ directory, and then double-click the 
‘maindata’ directory it contains. 

 

 
 

4. Select the project file called ‘ccwlf06’ from the list on the left side of the dialog 
and press OK. 

5. Select the Data Base CCWLF file you want to work with from the list on the left 
side of the dialog and press OK. 

 

 
 

When the project opens, you’ll see a premier View, prepared by us, named ‘Caspian 
Sea Basin Countries’.  

 

 



WWWooorrrkkkiiinnnggg   iiinnn   ppprrrooojjjeeecccttt   
We created an ArcView project ccwlf06.apr, containing eight different Views: 
 
We decided to have only fourteen buttons on our new interface: one to display each 
View and four for execution of some tasks. Also six instruments were entered for 
object choice on the map by their attributes.  
 
ArcView is made up of layers of geographic information for a particular area or place. 
Each layer is collection of geographic features, such as rivers, lakes, countries or 
stations. In ArcView, these layers are called themes.  
All the themes in view are listed to the left of the map in the view’s Table of Contents. 
The Table of Contents also shows the symbols used to draw the features in each 
theme. The check box next to each theme indicates whether it is currently turned on or 
off in the map, that is, whether is currently draw on the map or not.  
The order in which the themes are listed in the Table of Contents is also important. 
The themes at the top of the Table of Contents are drawn on top of those below it.   
For making this theme active click on the it name. Be sure to click on the name of the 
theme, not the check box next to the theme name. By making a theme active you are 
telling ArcView you want to work with the features in that theme. Click 
the Open Theme Table button. The attribute table appears. A theme attribute 
table contains information about the features in that theme, one record for 
each feature. 

To change the order a  theme is drawn in 
Drag the theme up or down in the Table of Contents. When you drop the theme in its 
new position, the view will automatically redraw. 

The Buttons and Tools for moving around a map 
 
Zoom To Full Extent Button. Zoom to full spetial extent of the all themes 
in our view. For example, if you’ve zoomed in a couple of times on your 
view? You can click this button if you want to see the whole view again. 

 
When you selected a tool and move the cursor the view, the cursor changes shape to 
reflect the tool you selected. The tool remains selected until you choose a different 
one. 
 

Zoom in Tool.  To zoom in centered on a particular position on the view, 
click that position once with this tool. To zoom in to a particular area on the 
view, drag a box over the area with this tool. 
 
Zoom Out tool. Same as the Zoom In tool but zooms out from the position 
you click or the area you drag over. 

 
 

Pan tool. Lets you pan the view by dragging the display in any directions 
with the mouse. To pan, click this tool, move the cursor anywhere over the 
view, hold down the mouse button, and drag in any direction. Release the 

mouse button to leave the view in your desired position. 
 



 

Identifying features on our map 
To get information about one of the features on our map, use the Identify tool. 
When you click on a feature with this tool, ArcView displays the attributes of the 
feature in a dialog. 
 

 
 

To identify a feature on a map 
1. In the view Table of Contents, click the name of the theme that the feature you 

wish to identify belongs to. This makes the theme active. When a theme is active, 
it appears highlighted (raised up) in the Table of Contents. 

 
2. Click the Identify tool  
 
3. Click on the feature you wish to identify. The feature you click on flashes in the 

view, and its attributes appear in the Identify Results dialog. 
 
If you to identify a feature but you aren’t sure which theme it belongs to, make all the 
likely themes active before using the Identify Tool. To make more than one theme 
active, hold down SHIFT and click on their names one by one in the view table of 
Contents. 
 

Finding features with particular attributes 
 
The Identify Tool is the best suited for browsing data. To get the attributes of specific 
features in a theme and then work with them, it’s best to select the features on the and 
then open the theme attribute table to see their attributes. When you select features on 
a view, they highlight to show you are selected. Features remain highlighted until you 
make a different selection, or you deselect them. When you open the attribute table of 
the theme they belong to, you’ll see that the records for the features you selected are 
also highlighted. 
There are various ways to select features in ArcView. 



Selecting features with the mouse 
To select a feature in the active theme using the mouse, click on the 
feature with the Select Feature tool.     To select more than one feature, hold 
down SHIFT when you use the tool. You can also use this tool to drag a box over a 
group of features you want to select. Features that fall partly or wholly inside the box 
you define are selected. 
Suppose, you are looking at  Hydrological stations’ map and want to see the attributes 
of the particular stations located in Ural River Catchment.  
 
1. Click the name of the theme containing the features you wish to select, in this case 

hydrotype, to make it active.  
 
2. Click the Select Feature Tool, hold down SHIFT, and click the 

stations you are interested in. They will yellow to indicate they are selected. 
 

3. Click the Open Theme Table button  to display the attribute table for the 
Hydrotype. This table contains one record for each station from CCWLF BD. 

 
4. Click the Promote button to display the records for the selected 

stations at the table top. 
 

 
 
When you quit ArcView and save your project, ArcViw automatically remembers 
which features you selected. The next time you open project, the same features will 
still be selected. 



Refining the selected with the mouse. 
Now suppose you decide to remove one of the stations from the selection and add two 
more. 
1. Click the title bar of the view window to make it active. 
2. Holding down SHIFT, use the Select Feature tool  to click on the 

station you wish to remove from the selection, then click on the 
stations you wish to add to the selection. 

3. Click the title bar of the table window to make it active. 
 
4. Click the Promote button to display the records for the selected 

stations at the table top. 
 

 
 

Selecting features by selecting their records. 
You can also select and deselect features in your view by clicking their records in the 
theme attribute table. 
 
Click the Select tool  and clock the record you want to select. To select more than 
one record, hold down SHIFT and click on the records one by one, or drag down over 
the records. To deselect the records in the table is useful because you can select the 
features you are interested in as you look at their attributes.  
 
There are some more tools for comfort data performance in the attributive table. You 
can find them in the table menu. 
 
Further shows you how to perform queries with expressions to automatically select 
features with particular attribute values.   



Finding individual features on a map 

You can use the Find button  to locate a particular feature in the active theme. 
For example, suppose you are looking at the Administrative Units’ map and you want 
to find Volgogradskaya oblast. 
 
1. Click on the name of the theme that contains the feature you wish to find, in this 

case Admin_units, to make it active. 
 
2. Click the Find button.   
 
3. In the dialog that appears, type in the Volgogradskaya oblast word. You can enter 

part of the text. 
 

 
 
4. If a feature is found it is selected and highlighted on the map. The map also pans 

automatically so that the feature is displayed in the center. 
 
 

 



 

Finding features by building a query expression 
A query expression is a precise definition of what you want to select. Building a query 
expression is a powerful way to select features because an expression can include 
multiple attributes, operators, and calculations.   
 
 In this example, imagine, you’ve got the Hydrometeorological Classification map, 
and want to find meteorological stations which didn’t make the precipitation data. 
You can build an expression to specify these criteria. 
1. Click the name of the theme containing Features you want to find, in this case 

Meteotype, to make it active. 
 
2. Click the Query Builder button. The dialog that appears lets 

you build the query expression by either on fields, operators, and 
values, or by typing it in. The Fields list shows you  the all fields in the DB table.  

 
3. In the fields’ list, double-click the Precip_for_arcview field to enter 

[Precip_for_arcview] into the expression. 
4. Click the “=” button to enter the = operator into the expression.  
 

 
 

5. Click the New Set button.  
 

• New Set: make a new set containing the features selected in your query 
expression. Any currently selected features not in this set are 
deselected.  

• Add to Set: Adds the features selected in your query expression to the 
existing set of selected features. Use this option to widen your 
selection. (If there is not existing selected set, this option works the 
same as New Set). 

• Select From Set: Applies your query expression only to those features 
that are already selected. Features in the existing selected set that are 
not selected by your query expression will be deselected. Use this 
option to narrow down your selection to progressively focus in on the 
features you want. 

 



 
6. ArcView executes the query and features that are selected are highlighted in your 

map. 
 

 
To find out how many features meet the criteria in your expression, or to review the 

attributes of the selected features, click the Open Theme Table button . The 
number of records that are currently selected is displayed in the tables’ tool bar. 
 

 



 
Combining different query techniques in this way can help you solve a wide variety of 
problems. The ability to query your data according to spatial relationships and tabular 
attributes is one of the key benefits of using ArcView. 

LLLoooaaadddiiinnnggg   tttaaabbbuuulllaaarrr   dddaaatttaaa   fffrrrooommm   dddaaatttaaabbbaaassseeesss   
Using ArcView SQL connection feature, we can connect to one of databases from   
CCWLF, and run an SQL query to retrieve records from it. The records you access 
become a table in our project.  For example, we may have meteorological data for the 
different stations, show on the map. By adding our data to the map, we’ll be able to 
symbolize, label, query, and analyze the states according to this data 

To load data by connecting to a database 
1. Make the any project window active. 

2. From the Project menu, choose SQL Connect.  
3. In the dialog that appears (see the picture below), the Connection list shows all the 

database connections available to you. Choose the database CCWLF containing 
the data you wish to load into ArcView and press the Connect button. This 
enables you to log into the database you chose. 

4. The Table list shows you the tables available in the database we are connected to.  
You can click on a table to list the columns (field) it contains. Use the Tables and 
Columns list to compose an SQL query by specifying which columns from which 
tables you wish to bring into ArcView. Double-clicking a column name adds it to 
the Select box. Double-clicking a table name adds it to the From box. 

5. If you want restrict the records that will be retrieved to specific subset, type a 
selection expression into the Where box. It is better for us to load all data from 
database, and then choose records with a help of query expression if we need this. 

6. In the Output table box, specify a name for the table that ArcView will create to 
store this data. 

7. Press Query. 

 
 
In this SQL query, records for all columns in the table Air_Temperature_Monthly. 



ArcView will create a table containing the records you specified from the database.  
 

 
 
ArcView stores the definition of the SQL query, not the records themselves. When 
you open a project containing a table representing the results of an SQL query, 
ArcView will automatically reconnect to the database to obtain to the data for your 
table. Any changes in the database will therefore be reflected in your table, and in any 
views, charts, or layouts in which you use data from this table. In addition, at any time 
you can choose Refresh from the Table menu to automatically reconnect to the 
database and retrieve the records for your table, so you can be sure it contains the 
latest information.  

So ArcView will create any table containing the records you specified from the 
database. 
 

Finding features by building a query expression in the table made by 
SQL query 
 
 In this example, imagine, you’ve got data of Monthly Air Temperature, which were 
got at Baku station in 1999, 1997, 1969 and 1967. You can build an expression to 
specify these criteria. 
1. Click the Query Builder button. The dialog that appears lets you build 

the query expression by either on the fields, operators, and values, 
or by typing it in. The Fields list shows you all the fields in the DB table. We’ll 
start by building the part of the expression to do with Stations’ Name. 

2. In the fields’ list, double-click the Name Stations to enter [ClimateEng] into the 
expression. 

3. Click the Equal button to enter the = operator into the expression.  
4. The Values list shows you the unique values in the table for the ClimatEng field. 

Scroll and double-click “Baku”. 
5. Now we’ll build the part of the expression to do with years. Click the And button 

to indicate that both parts of the expression must be true. ArcView automatically 
follows this operator with a part of parentheses for the next part of expression. 

6. In the list fields, double-click the Year field. 
7. Click the Equal button. 
8. The Values list shows you the unique values in the table for the Year field. Scroll 

down and double-click “1999”. 



9. Click the New Set button.  
10. Reword points from 2 to 9 for 1997, 1969, 1967 years, changing click the New Set 

button on Add to Set button.  
 

 
 

 
11. Click the Promote button. This brings the selected records to the 

top of the table so you can see them together.  
 

 
 

CCChhhaaarrrtttiiinnnggg   ooouuurrr   dddaaatttaaa   

Creating a chart 
When you want to communicate the numeric values and the relationships among 
them, charts provide immediate visual impact and take less effort to understand than a 
table or a verbal explanation. 
The Chart you make will only represent the selected records. If no records are 
selected, your chart will represent all the records in the table. 
 
1. Click on the title button of the Meteorology View to make it active.  
 
2. Click the Create Chart button. 
 
3. Choose SQL Table, for example, Air_Temperature_Monthly. 
 



4. The dialog, that appeared, contains a list of numeric field in your table. Click the 
name of the field you wish to chart, and click the Add button. The field is added to 
The Groups list in the dialog. If you wish to chart more than one field, click each 
field and click the Add button to add it to the Groups list in the same way. 

 

 
 
1. From the drop-down list, choose the field you wish to use to label the data series 

in the chart.  
 
2. Optionally, type a new name for the chart in the Name field at the top of the 

dialog. 
 
3. Click OK. ArcView displays the new chart using the column chart type (The 

default). 
 
4. Change the type according to your needs. 
 

To change the style used by your chart 
 Area charts.  These show the difference between two or the data groups.  
 

Bar charts.    Column charts. These are good for comparing values and 
showing trends. 

 Line charts. These emphasize rate, so change so are particularly good for 
representing over a period of time. 

 Pie charts. These show relationships between the part and the whole, and 
particularly useful for showing proportions and rations. 

 Scatter Charts. These reveal trends or patterns in data, and can help you reveal 
cause-and-effect relationships. 



Identifying a data marker 
You can identify a data marker in a chart to display all attribute information from the 
associated record in the table. Identifying a data marker is helpful when you want to 
see the exact value of data marker, or when you want to see the value of an attribute 
that’s not being charted. While you could see the same information by looking at the 
table, identifying a chart data marker is easier when the table is closed, or if the table 
is very large. To identify a data marker on a chart, click the Identify tool  and click 
on the data marker you want to identify. 
 

 
 
 

Changing chart elements 
The chart elements, (its title, legend, and axes) can be individually moved, hidden, or 
modified. To change or move any chart elements click the Chart Element Properties 

tool,  and click on the Element you want to change. A dialog is displayed in 
which you can specify the properties of the elements. 
There are a lot of the other tools for changing diagram view. You can find them in 
Menu Diagrams.  

LLLaaayyyiiinnnggg   ooouuuttt   aaannnddd   ppprrriiinnntttiiinnnggg   mmmaaapppsss   
A layout lets you assemble the all components you want to appear in a map, arrange 
them together to get the design you want, and the print it out when it’s ready. Layouts 
make it easy to produce presentation quality maps with ArcView. You can place more 
than one view onto your layout, along with any of the charts and tables in your 
ArcView project.  
 
1. Choose the view, which you want to situate in the group. 
2. From the View menu, choose Layout. 



3. In the dialog that appears, click the Landscape template. Press OK. 
4. In the dialog that appears, select a Layout. Press OK. 
 

 
 

5. If you choose «New Layout», ArcView automatically creates a layout that 
includes your map, a legend, a title, a north arrow and a scale bar  

 
A layout makes it easy to produce presentation quality maps with ArcView. With a 
layout, you can assemble all the components you want to appear in your map, arrange 
them together to get the design you want, and then print it out when it’s ready. You 
can do this by Layout tools.  
 
6. If you have chosen layout, which had been already prepared by us, you have to 

remember that all components (charts and tables) must be active for correct data 
output. 

 
 Some layout data variants from our project you can in the Appendix.  
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